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Preface 

For some time now, the digital era has begun in the field of 

transcription and text analysis. Back in the day, a cassette recorder 

with a sizeable microphone was placed on the table when someone 

wanted to conduct an interview. While a little bit smaller than the 

Myfirst Sony, it was still big enough that one couldn’t miss noticing it 

during the interview. Today, a small digital recording device is placed 

on a table. It is hardly bigger than a cell phone, and it is capable of 

even recording group conversations in large rooms without having to 

connect an external microphone. No cassette tape needs to be 

flipped or changed during the recording; gigabytes of digital memory 

allow us to record hours and hours in excellent quality. 

With such a modern device, the life of a recorded interview in the 

social sciences is a strictly digital one. After the interview, the 

recording device is connected to a computer via a USB port and the 

digital transcription can begin using specially designed software – for 

instance f4. Now, simply import the transcribed data and the original 

audio file into qualitative data analysis software, such as MAXQDA, 

and you can start the analysis. The researcher now has synchronized 

access to the text, to audio data and to images.  Incredibly simple, 

right? 

Not entirely – looks may be deceiving. There are a number of 

substantial decisions to be made before a researcher reaches this 
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point.  For instance, appropriate transcriptions rules need to be 

chosen, and the advantages and disadvantages of different 

transcription rule systems need to be considered. If one is to inform 

him/herself in this regard, he/she quickly realizes that there is a lack 

of instructions aimed at practice. All in all, literature on the subject of 

“transcription” is sparsely found, the available literature is highly 

specialized and consequently complicated enough to be of little help 

for decision-making. 

This brochure, written by Thorsten Dresing, Thorsten Pehl and 

Christian Schmieder, fills a painful gap felt by all beginners. This is a 

text which finally addresses and answers all questions concerning 

transcription in day-to-day research in a practice-oriented way. It 

would be, of course, presumptuous to assume that transcription – a 

time-consuming task which is otherwise fulfilled rather grudgingly – 

would now be fun. Nonetheless, the authors have thought to compile 

a text which, in a comprehensible way, describes how to efficiently 

transcribe – and is fun to read. 

We all dream of transcription being done automatically one day, but 

this is still a long way down the road.  So far, speech recognition 

software relies on being trained to one’s own voice, which renders it 

unsuitable for individual and group interviews. Thus, transcribing 

data is an unavoidable prerequisite before conducting computer-

based analysis.    
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Transcription is an effort worth taking. Only through this effort can 

the numerous methods, ranging from grounded theory to qualitative 

content analysis, be applied in an efficient way. One is close to the 

data and is able to code, write memos, discover and visualize 

interconnections, interlink passages and even refer back to the 

original audio if necessary.  

The digital revolution has also changed the methods of social 

research in a profound way. At first glance, it appears as if today 

nearly everyone can do almost everything without much preliminary 

training, and as if everything could be very easily done.  At a second 

glance it becomes apparent that the advanced possibilities also 

demand for a higher degree of professionalization, such as informed 

choices concerning transcription rules and the manner of the text 

analysis that follows. This brochure is an important component of 

this professionalization since it provides young professionals with 

everything they need concerning transcription. Therefore, I hope that 

this manual reaches many readers.  

Udo Kuckartz, June 2011 
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How to choose a recording device 

Most qualitative researchers face the same question when preparing 

for their projects: Which recording device is best for recording my 

data? We had the same issue six years ago, when we (Thorsten 

Dresing and Thorsten Pehl) conducted our dissertation projects and 

started looking for a recording device for our own qualitative 

interviews. We tested all available gadgets ourselves, since no one 

else could provide us with a satisfying answer to this question. Ever 

since then, we have been testing recording devices and sharing the 

results with other researchers on our website 

http://www.audiotranskription.de/english . Our website provides an 

extensive and a consistently growing collection of recording 

equipment tests and comparisons of digital recorders. Today, we not 

only look for the best devices for interviewing, we also test and 

review equipment for recording music, ambient sound, dictation, 

nature sounds and more. In order to share more about our 

experience testing countless recording devices, we created the 

following guidelines to help others choose a recording device for a 

qualitative research project.  

Recording quality 

Obviously, recording quality itself is an important issue. It is crucial 

what “gets into the ears.“ However, there is no device with the ‘best’ 

recording quality. Many devices deliver outstanding recordings, 
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though with different recording characteristics. Whether these 

characteristics are ‘good’ depends on the recording situation.  

Let’s say you want to record narrators in order to create an audio 

book. This requires a voice recording which is as clear as possible and 

without ambient noises. There are devices that do this very well. But 

the same devices fail or do poorly when recording the sound of a 

drizzling rain or a chirping cricket. 

You should always consider in which recording situation (e.g. 

interviews, ambient recordings, or music) and recording settings (e.g. 

in a studio or outside) you want to use the device. On our website, 

you can listen to sample recordings from several recorders 

(http://www.audiotranskription.de/english/fresh-sounds-in-2012). 

When listening, you should assess the sound quality with regard for 

the following four aspects: 

 

 Voice & detail perception: How good can you recognize & 

distinguish between the narrators and the sources of other 

sounds? The subtler, yet distinguished the nuances are, the 

better. 

 Noise level: How strong and perceivable is the hissing and 

humming background noise, especially during quiet passages? 

The less, the better. 

 Perception of space: How good is the impression of depth and 

space? Do you get the feeling that you are immersed in the 
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recording situation or is the recording unnaturally flat? The 

more natural the space perception, the better the recorder is 

suited for recording atmosphere and group conversations; the 

more flat the recording, the better for recording individual 

speakers. 

 Representation of sound pitch (high and low):  Are high or low 

frequencies emphasized? When recording individual speakers, a 

pleasant sonority, or depth of sound, is often preferred, for 

room atmosphere recordings, a clear emphasis of high pitches 

is preferable. 

Suitability for daily use (handling, battery life, craftsmanship and 

reliability) 

In our opinion, this is a very important issue. Can the device be 

operated intuitively? Are the important functions easily accessible? Is 

the display easy to read? Does the battery last at least for a working 

day? How is the recorder designed and constructed? Are there flimsy 

parts? Is the recorder made mostly from plastic or metal? Are the 

buttons easy to press or do they wobble around? All of these things 

can be easily assessed if you hold the recorder in your hand, but 

product descriptions and photos alone do not provide reliable 

information. To compensate for this, we also focus on handling 

aspects and haptic perception in the reviews.  

From our experience distributing recording devices via our website, 

we can make a few assertions regarding the reliability of some 
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recording devices based on those which have been returned to us 

under warranty for repair or replacement. We have noticed rather 

clear differences in product quality depending on the brand. Devices 

made by Olympus and Sony are very rarely sent back to us (fewer 

than 1 in 1,000), whereas products by Zoom and Tascam are returned 

more often. It must be duly noted, however, that this information is 

not universally valid for all devices and only applies to those we 

distribute. 

Recording & file formats 

For transcribing qualitative interviews and group discussions, MP3s 

provide an appropriate compromise between file compression, 

recording quality and flexible (cross-platform or cross-computer) file 

handling. Please make sure to use a set (not a variable) bit rate when 

generating an MP3 file. The WMA file format is equivalent to MP3s in 

terms of sound quality, but it cannot be played on Macs® without 

certain limitations. In principle, uncompressed recordings in PCM-

WAV format can be used, but they barely provide quality advantages 

in interview settings and consume up to tenfold of the space on your 

computer or USB stick. A good many other audio and video formats 

are easily and quickly converted using free software.  

If your data requires more complex processing, such as phonetic 

analysis or signal analysis, it is important that the recordings are 

available as uncompressed WAV files. Also, if your recordings are to 

be made available at a later date for linguistic databases, it is 
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preferable to use WAV format. Archives (such as the LDC in the USA, 

the ELRA in Europe, the BAS and IDS in Germany, and the MPI 

Nijmegen (for ethnological recordings)) require a file format which is 

open access and cross-platform, and which can be produced and 

used free of licensing while guaranteeing optimal quality. In practice, 

these demands mostly lead to using the WAV format. If you are 

interested in learning how to transform audio files, please refer to 

the chapter ‘Converting audio files’ in this manual 

DSS and DSSPro file formats used in dictaphones are unsuitable for 

transcription in the context of qualitative research or linguistic 

research. The sound quality is substandard and the file format 

requires proprietary software and hardware. Please note that 

converting these files into MP3s at a later point does not improve the 

sound quality.  

External input 

Current audio recorders usually have good internal microphones; for 

recording interviews and group discussions no additional external 

microphones are necessary. However, in certain situations, being 

able to connect an external microphone may be a positive aspect 

when choosing a recorder. Does the device feature a line-in as well as 

a separate microphone input (which is preferable)? Does the device 

offer genuine inputs for XLR-microphones with phantom power or 

only a 3.5mm jack plug? A 3.5mm jack plug can be flexibly used with 

many types of microphones:  for instance with some lavaliere-style 
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microphones or with the output from a Hi-Fi-system for the purpose 

of digitalization. XLR-microphone inputs are vital for professional 

vocal microphones and for connecting to mixing consoles. The inch-

thick XLR-plugs lock in firmly and they are suitable for situations 

calling for more a more sturdy connection. 

Important functions 

Long lists of device functions can easily be found in the product 

descriptions. In the case of recording interviews and group 

discussions, “automatic level control” is a term you should pay 

attention to. This means that the recording volume is automatically 

adjusted by the device. This is important if you don’t want to be 

constantly glimpsing at the fader controller/meter while recording. 

The adjustments of this automatic level control can be perceived as 

light volume fluctuations. This is great for interview recordings, 

however, it is not recommended for music recordings. 

Accessories and cost 

For a good interview-recording device you should at plan a budget of 

roughly 200 Euros or 300 Dollars. When comparing prices, we 

recommend that paying attention to the accessories that come with 

the device because these may explain a higher price range. For 

recordings outside, we absolutely recommend a windshield. Even a 

slight breeze can make the recording inaudible. The sponge 

windscreen supplied with some devices does not always provide 

effective protection. 
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Sample recordings 

If you consider these aspects you will reliably be able to choose the 

best recording device for YOUR purposes. The necessary information 

you need for that can be gathered from our many current (older) 

comparisons and individual tests on digital recorders. We compile 

these test reports with a lot of pleasure and using our ears – not on 

the basis of frequency measurements or technical data sheets. We 

listen “blindly“ to sample recordings as a team and evaluate every 

recording individually. Afterwards we discuss, as a team, the results. 

Thereafter, we reveal/disclose which devices belong to the respective 

recordings. You can retrace our results for each device and even 

listen to sample recordings on: 

http://www.audiotranskription.de/english/fresh-sounds-in-2012  
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Producing transcripts: The challenge of producing a 

text 

Different transcription conventions – different data 

Transcription (lat. trans-scribere = “to write over”) is the transfer of 

an audio or video recording into a written form. A transcript usually 

originates from manually typing out the recorded content. Typically, 

recorded conversations, interviews or dictations are subject to 

transcription. 

Verbal statements are evasive and highly complex; it is not possible 

to remember each and every detail of a spoken conversation. The 

aim of transcription is to overcome this problem. In a transcript, 

speech is represented in writing, and therefore stabilized: you can 

look at a word or a passage as long as you want to, and you can easily 

navigate back to it. This makes the recorded information more 

accessible and thereby more useful for analysis. The goal of 

transcription is to represent speech as detailed and multifaceted as 

possible in order to provide the reader with a good representation of 

the conversation and to thereby provide him/her with a good 

foundation for its reconstruction. This is done, for example, by 

including pauses, intonation, or overlapping speech in transcripts. But 

too many details and too much information can also make a 

transcript difficult to read. This tension between the need for 
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accurate representation and practical limitations require researchers 

to find a balance between the two poles.  

There is a second reason that makes transcription an almost 

paradoxical task: with the pretense to accurately represent the multi-

faceted verbal discourse, you create a written text that is a linear, 

one-dimensional document. In the end, transcription is a matter of 

compression, and this compression needs to be guided by conscious 

decisions by the researcher (for a great discussion of this process, see 

Skukauskaite 2012). Hence, the challenge of transcription lies in 

knowing about this discrepancy and in dealing with it as adequately 

as possible with respect to your methodological needs.  

Anyone who transcribes or who works with transcripts should be 

aware beforehand that a transcript can never fully grasp the 

recording situation. Too many elements factor into communication, 

and it is impossible to transcribe them all. Even a transcript that has 

captured sounds in a very accurate way (e.g. phonetic transcription in 

linguistics), may omit non-verbal aspects such as odor, the room 

setting, time setting, visual components of the setting, facial 

expressions and gestures. It is therefore impossible to not draw a 

focus upon certain aspects of communication or speech.  However, in 

order to comply with the quality standards of qualitative research, it 

is crucial to deliberately set this focus according to the aim of the 

research conducted or to the intended use of the transcript.  
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Leaving out – or including, or transforming – certain aspects of 

recorded speech may radically change the content a transcript 

conveys to its readers (especially if they do not have the chance to 

listen to the recording, or if they have not been present in the 

recording situation). An example: A researcher asks a manager 

whether he/she will cut jobs next year. The manager takes ten 

seconds to think, rubbing her chin. She then looks down to the floor, 

quietly stating “naaaaaho“. This statement could simply be 

transcribed as “no". Another option would be to include pause 

length, gestures, speech volume and pitch in the transcript as well. A 

reader is very likely to interpret the same statement in the two 

transcripts in different ways.  

In simple transcripts, paraverbal and non-verbal elements of 

communication are omitted. Dialect and colloquial language 

elements approximated to standard language. The focus of a simple 

transcript lies on readability. It is easier to learn to produce such a 

transcript, and it takes less time to transcribe the data. The 

transcription conventions according to Kallmeyer and Schütze (1976) 

and Hoffmann-Riem (1984) focus on this goal. Their conventions 

were supplemented by Kuckartz, et al in 2008, who consider 

increasingly common usage of qualitative data analysis (QDA) 

software. For this manual, we have revised and enhanced their 

suggestions. In many contexts for qualitative research, simple 
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transcription rules have became a standard – not least because of 

time restrictions in (academic) qualitative research.  

A detailed transcript with a complex set of transcription rules is 

necessary if the intended analysis does not focus on the surface 

semantic content of a conversation. In such cases, prosodic elements 

(e.g. intonation, primary and secondary emphasis, voice volume and 

the speed & pitch of speech) are included. If necessary, a phonetic 

transcription is added (e.g. in research on dialect), or non-verbal 

phenomena are depicted in an even more complex way (e.g. in 

research on gestures or deictic expressions). 1 

To illustrate the difference between a simple and a more detailed 

transcript, we have included two short transcript passages below. 

They originate from the same recording, but they have been 

transcribed according to different conventions.  

Simple transcript Complex transcript 

S1: ...or whether they'll get 

divorced after all. 

S1: =<<dim>  or WHEther  they'll 

get divoced  ↑`after all.> 

S2: Hm. (...) S2: ˇhm, 

(- -) 

S1: This is still. (...) . It is a 

transition. 

 S1: <<pp>  this is still - > 

((breathes out for  2.1 sec)) <<p> 

t'is a  ↑` transition.> 

                                         
1
 While simple transcripts can be easily produced in word processors and specialized programs such as f4, more 

complex transcriptions need partitures in order to represent an increased amount of complexity. Transcriptions 
in partiture also call for specialized data analysis software in order to be produced and managed (eg. ELAN or 
Transana) 



Manual (on) Transcription   1st Edition  Page 18 

S2: Our former neighbors, they are 

a good example for this. (...) 

Married for thirty years  (...) the 

last kid was finally out of the 

house, took off to study, (...) left, 

you know, to Berlin. 

S2: our former neighbors  ↑` they 

are a good example for this 

(- - -) 

err (- - -) 

↑ married for THIRty years °hh 

the last kid (.) `finally outta-the 

´HOUSE, 

took off to STUdy, (-) 

´LEFT, =´you know, °h 

to ber´LIN, °h 

As you may have noticed, the simple transcript provides faster access 

to the surface content of the conversation. Details concerning 

intonation are omitted, which makes the transcript easier to read. 

The detailed transcript, on the other hand, provides the reader with a 

better impression of how the participants spoke since it includes 

intonation and vernacular. Participant 2 comes across more 

enthusiastic and interested, since he/she repeatedly emphasizes 

syllables.  This aspect does not become that clear in the simple 

transcript. However, the many breaks the speaker makes are more 

obvious in the simple transcript.  

You should decide how – and what – to transcribe according to your 

research method, your research expectations and pragmatic reasons 

(readability and, connected to the latter, time). You should not “just 

start” transcribing before thinking about the following questions:  

 For what kind of analysis do I produce my transcript? 
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 What information should the transcript include? 

 Is it important to include emphases? 

 Does vernacular or dialect have to be represented in the 

transcript? 

A clearly defined transcription convention and transcription rules 

help you make your transcripts comprehensible to yourself and to 

others. In the following chapters, we introduce a couple of 

transcription conventions, which may help you finding the 

transcription style best fitting your research needs.  
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A simple transcription procedure 

Kuckartz et al. provide “consciously simple and quickly attainable 

transcription rules, which considerably smoothen language and set a 

focus on the content of the verbal contribution.“ (2008, p.27, 

translated) 

We have applied this system in many extensive research projects, 

each of them involving several transcribers at the same time.2 We 

have received feedback from transcribers, lectors and researchers 

who worked on transcripts obtained from hundreds of hours of 

interviews. Their feedback helped us to modify these guidelines and 

to add a few hints.  

The underlying transcription rules 

1. Transcribe literally – do not summarize, but do not transcribe 

phonetically. Dialect and colloquial language are to be 

accurately translated into standard language. If there is no 

suitable translation for a word or expression, the dialect or 

colloquial language is retained. 

2. “Merged” words are not transcribed as such, but approximated 

to standard written language. For instance:  “I‘m-a-goin’ to the 

movies“ is transcribed as “I am going to the movies“. The 

general construction of a proposition is retained, even if it 

                                         
2 We presently provide transcription services (German only). The collaboration with our 40 typists further 

informed the development of the following transcription system.  
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contains syntactic “errors”, for example: “To the shopping mall I 

went.“ 

3. Discontinuation of sentences or abrupt stops within a word are 

indicated by a slash:  / 

4. Punctuation is polished up in favor of legibility. A short drop of 

the voice or an ambiguous intonation is rather indicated by a 

full stop than a comma. 

5. Pauses are indicated by full stops in parentheses, corresponding 

to the pause length from 1 second (.) to three (…) seconds. 

Longer breaks are indicated by the pause length in parentheses 

(15).  

6. Consentient or confirmative vocal interjections by the 

interviewer (like ’mhm’) are not transcribed. Interjections by 

the interviewee such as ‘mhm’, ‘ehm’ and ‘uh’ are also not 

transcribed. Monosyllabic answers, however,  (positive: ‘mh = 

hm’, ‘ah = ha’  or negative: ‘hm = mh’, ‘eh = eh’) are always 

included in the transcript, if appropriate as ‘mhm (affirmative)’ 

or ‘hm-m (negative)’. 

7. Emphasized words and utterances are capitalized. In the case of 

the emphasis of the personal pronoun “I”,  (or an emphasized 

“a” in the beginning of a sentence) we recommend to underline 

it in order to indicate emphasis.  
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8. Every speaker receives his/her own paragraph. There is a blank 

line between the speakers. Time intervals are inserted at the 

end of a paragraph, at the least. 

9. Emotional, non-verbal utterances (of both the interviewee and 

the interviewer) that support or elucidate a statement (such as 

laughter, giggling or sighs) are transcribed in brackets. 

10. Overlapping speech can be separately transcribed and 

separated by speakers. Passages with overlapping speech are 

indicated by double slashes at the beginning and end of the 

overlap: 

I:  // Oh, then you // 

P: // Exactly, then we // finally arrived. 

11. Incomprehensible words are indicated as follows: (inc.). 

You should indicate the reason for not being able to 

comprehend the audio if you come across longer inaudible 

passages, eg:  (inc., cellphone ringing) or  (inc., train passing by). 

For longer incomprehensible passages, you should also indicate 

how long the respective passage was, e.g. (inc., train passing by, 

19 sec). 

12.  If you assume or guess a certain wording, the word or 

passage should be put in brackets and be supplemented with a 

question mark in brackets. For example: (xylomentazoline?). 

Generally, all inaudible or incomprehensible passages are 
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marked with a time stamp if there is no time stamp close by (1 

minute before or after the respective passage). 

13. Disturbances are noted in parentheses: (passing train, 10 

seconds) 

14. The interviewer is marked with an “I:“, the interviewed 

person with  “P:“ (for participant). If there are several speakers, 

(e.g. in group interviews), a number can be added to the name:  

(e.g. “P1:“) You can choose other, unambiguous names or 

abbreviations as well (e.g. “Peter:“). 

15. The transcript is saved in rich text format (.rtf file). This 

ensures compatibility with most word processing programs and 

even older qualitative data analysis programs. The name of the 

saved transcript should correlate with the audio file name. For 

example: interview_04022011.rtf or interview_smith.rtf 

Hints toward creating a consistent transcript 

These aspects concern the notation and may help to ensure that 

transcripts are consistent (especially if there are several people 

transcribing in your team). 

1. Symbols and abbreviations such as percentage and meter are 

spelled out. 

2. Contractions or abbreviations are transcribed exactly the 

way they were said, e.g. ‘can’t’ instead of ‘cannot’ or ‘stats’ 

instead of ‘statistics’  
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3. English spelling conventions concerning capitalization are 

also applied in an English transcript.   

4. Numbers are transcribed as follows: 

a. Zero to twelve are spelled out, larger numbers are 

transcribed as numerals. 

b. Other numbers that make short words are also spelled 

out, especially round numbers: twenty, hundred, three 

thousand. 

c. Decimals and equations are always written in numerals. 

Thus: “4 + 5 = 9“ and “3.5“. 

d. Roughly estimated figures are spelled out, accurate 

figures are written in numerals. For instance: “The fifty 

million Euros of government debt“. 

e. If there are fixed conventions concerning how to write 

down numbers, follow those conventions. House 

numbers, page numbers, telephone numbers, account 

numbers, dates or the like are never spelled out in full. 

For instance: “on page 11“ or “16 Broad Street“. 

5. If direct speech is quoted in a recording, the quote is 

enclosed with quotation mark, e.g.: and he said “let’s see 

about this“ 

6. Proper nouns are transcribed according to the rules of the 

language you are transcribing in.  
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7. Enumerations are transcribed with a capital letter without 

brackets (‘I like it because A I think it is affordable, and B 

because I always wanted one.’). 

Sample transcript 

I: Alright, what do you expect from your new field of 

study in Hamburg? # 00:01:01–0 # 

P: Well, first and foremost I want to learn a lot of 

new things about criminology and law. Well, I studied 

educational science as a major, and my minor subjects 

were sociology and peace and conflict studies in 

MARBURG. And now, I would like to get into law, get 

to know new people and get some new impressions. And 

I also want to (explore?) a completely new 

profession. #00:01:26-1# 

I: Okay, and what you expect concerning collaboration 

//amongst teenagers?// #00:02:11-2# 

P: //SO far, I have// no exact idea. For 

criminologists there is no particular everyday 

professional life. (…) How can I put this, in such a 

profession you can do a LOT of different things. 

#00:02:32-4# 
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A complex transcription convention: GAT2 

As opposed to the simple transcription notation mentioned in the 

previous chapter, more complex notation conventions draw an 

additional focus upon “how things were said”. By doing so, a 

qualitative analysis of the data’s phonetic and phonological features 

becomes possible. A complex transcript captures intonation, 

emphases, the exact length of breaks, overlapping speech, sudden 

cut-offs and cases of no breaks in between words. Such a transcript 

tries to represent more closely what was said in the recording 

(including dialect and colloquial speech). 

The transcription notation GAT (Gesprächsanalytisches 

Transkriptionssystem – conversation analysis transcription notation) 

is mainly used in the German-speaking discourse.  (cf. Dittmar 2004, 

pp. 150-164) During its development in 1997, the involved linguists 

had the goal to subsume existing notations in a unifying manner. 

While the GAT published in 1998 did distinguish between a basic and 

a refined transcript, the further developed version from 2009 (GAT2) 

introduced more fine distinctions between the poles (cf. 

Gesprächsforschung (10/2009) pp. 353 – 402).  In terms of 

complexity, a rudimentary minimal transcript is followed by a basic 

transcript, which can be developed further according to the 

researchers’ needs of inquiry. 

A minimal transcript can be easily produced with the transcription 

software f4 since in the case of the minimal transcript, merely 
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phrases carrying emphases, pauses, speech overlaps, laughter, etc. 

are transcribed. Details such as accentuations within words and a 

finer representation of intonation are left out. However, even when 

producing a basic transcript, f4 reaches its limits in terms of ease of 

use. Such transcripts are more easily produced with the free software 

PRAAT (www.praat.org).  

PRAAT has the advantage of displaying not only the sound file, but 

also an oscillogram and a spectrogram, as well as displaying a variety 

of values extracted from the sound file. This allows users to read 

accentuations and the voice pitch in a more reliable way, since the 

impression from listening to the data is complemented by visual 

information. 

There is a catch, however: PRAAT produces a transcript in the 

TextGrid file format. The full information contained in such files can 

only be accessed when opened in PRAAT. The files are absolutely 

unsuitable for further processing in a regular text editor.3    

Researchers at Albert-Ludwigs-University Freiburg have developed an 

award-winning, extensive online tutorial for GAT2, which helps users 

during their first steps with the notation system: http://paul.igl.uni-

freiburg.de/GAT-TO/. In this web tutorial, the rules and conventions 

of GAT2 can be learned through a series of examples and consecutive 

texts.  Here are some examples for transcripts according to GAT2: 

                                         
3 The free program EXMARaLDA (http://www.exmaralda.org) and its appendant editor for transcript partitures 
are able to import TextGrid files created with PRAAT, and can display them as text files. 

http://www.exmaralda.org/
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Example 1: Each intonational phrase is put into one line 

01 A: and what about this idea 

02 each flower get its own pot 

03 °hh but not a different fertilizer 

04 B: why not 

05 A: (-) it would be too expensive otherwise 

Example 2: Intonational phrases of a single speaker are linked 

consecutively and separated by the symbol “|”.  This transcript 

covers fewer rows, but cannot be expanded into a more elaborate 

transcript as easily.  

01 A: and what about this idea | each flower get its own  

02 pot | °hh but not a different fertilizer | 

03 B: why not 

04 A: (-) it would be too expensive otherwise 

Example 3: A basic transcript (cf. Dittmar 2004: p 349) already 

contains considerably more information:  

26 S2: an:d !EV!ery time he called the poLICE, 

27 and he started ARGuing with the NEIG [bors,=right, ](1.2) 

28 S1: [phhh hohoho] 

29 S2: and if someone just once used their HORN, 

30 he stood out there in NO time; 

31 and started YELLing;=  

32 =i'll call the poLI:CE  
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Transcription conventions in conversation analysis 

Using the transcription conventions developed in the English 

discourse on conversation analysis is another – quite similar – option. 

The system of transcript symbols in linguistic conversation analysis is, 

just as the more elaborated transcripts in GAT, quite complex (for an 

overview of transcription notations, see Jefferson 2004).4 However, 

Emanuel Schegloff did compile a more simple transcription 

convention for the social sciences based on the notation developed 

by Gail Jefferson 

(http://www.asanet.org/journals/spq/transcriptions.cfm)5, available 

on the American Sociological Association’s (ASA) website; another list 

of conventions is available on Charles Antaki's tutorial website on 

conversation analysis: 

http://www-staff.lboro.ac.uk/ssca1/notation.htm 

 

Sample Transcript according to Schegloff/ASA 

26 S2: .hhh an:d ↑EVery time he called the poLICE, 

27 and he started arguing with the neig[bors,=right,](1.2) 

28 S1: [((laughs))] 

29 S2: and if someone just once used their HORN, 

30 he stood out there in no time; 

31 and started yelling;= 

                                         
4
 This is no coincidence: The conventions developed in GAT are following – and modifying – the transcription 

principles of CA as developed by Jefferson (cf. Selting et al 2009: 353). 
5
 Note that this website does unfortunately not display the arrows indicating higher & lower pitch, as well as 

the sideway arrows indicating relevant lines for analysis. Those symbols are correctly displayed on Antaki’s 
tutorial site. 
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32 <=↓i'll call the poLI:CE>  

Amongst other details, this transcript features emphases (underlined 

text), it indicates louder passages (written in CAPITALS), more slowly 

spoken passages (in < >), and different levels of voice pitch (↓↑).  As 

in the case of any transcription notation, you should assess which 

aspects of the recording are important to you, and then decide 

whether to include them into your transcript.  

There is a series of educational tools for learning how to transcribe 

according to the conversation analysis' transcription notation. Two 

great places to start are  

Emanuel Schegloff's TranscriptionProject website 

(http://www.sscnet.ucla.edu/soc/faculty/schegloff/TranscriptionProj

ect/index.html) and Charles Antaki's tutorial website on conversation 

analysis (http://www-staff.lboro.ac.uk/ssca1/notation.htm). 

  

http://www.sscnet.ucla.edu/soc/faculty/schegloff/TranscriptionProject/index.html
http://www.sscnet.ucla.edu/soc/faculty/schegloff/TranscriptionProject/index.html
http://www-staff.lboro.ac.uk/ssca1/notation.htm
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How long does it take to transcribe? 

By no means underestimate the time that needs to be invested to 

produce a transcript! Oftentimes, one might not be aware that the 

transcription of an interview may take days. This can easily endanger 

the fragile schedule of a research project.  

The time needed to produce a transcript depends on how fast you 

can type, and on how complex the final transcript is intended to be. 

Although it is difficult to pinpoint an exact number of work hours, it is 

possible to estimate a reliable time frame.  The fastest transcription 

speed we have measured was a ratio of 1:3, meaning, it took the 

transcriber roughly three hours to transcribe one hour of interview 

data. However, the transcriber was only able to set this record speed 

because he/she only typed for about an hour, did not proofread the 

transcript, and applied only simple transcription rules. When applying 

very complex transcription conventions, transcription time increases 

considerably. Some researchers report that it took them between 30 

and 60 minutes to transcribe one minute of data (cf. Ehlich & Reede 

1994: 4; Lange 2008: 48). Aside from the complexity of the 

transcription rules, bad recording quality also influences transcription 

time in a negative way.  

According to our experience and our review of relevant literature, 

one should estimate five to ten hours to transcribe and proofread 

one hour of interview data (cf. Dresing & Pehl 2010: 726) – granting 

that simple transcription rules are used.  When working according to 
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the rules of a GAT2 basic transcription, the data is already partly 

interpreted, since transcribers have to make a high number of 

decisions during the process.6 This directly translates into an 

enormous increase in the time needed to produce the transcript: 

assuming adequate practice, 5 minutes of audio recording may be 

transcribed within 1.5 to 2 hours. Under ideal circumstances, this 

results in a ratio of 1:30 (recording duration: transcription time). If 

work pauses are included in order to prevent exhaustion, this ratio 

may increase up to 1:45. This demonstrates that transcribing verbal 

data is time-consuming work.  

In order to complete data transcription quickly, transcription 

software has proven to be useful. Furthermore we recommend 

working with hot keys instead of using a mouse while transcribing. A 

foot pedal further accelerates transcription by 10 to 30 percent. And 

keep in mind that pauses are necessary. It may sound trivial, but one 

simply cannot transcribe for 8 hours a day. The recommendations for 

the frequency of pauses in computer workspaces call for 5 to 10 

minutes of break per hour of work in front of the screen. This rhythm 

has proven itself in our experience. It is not realistic to expect to 

transcribe for 6 hours without increasing the rate of errors above the 

normal level.  

                                         
6
 One should note that every transcript is an interpretation – because transcription is a series of decisions 

concerning reduction, representation and transformation. Since a more complex transcript calls for more 
(conscious) decisions, it does take more time to produce it. 
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For example: you should expect 50 to 100 work hours for ten 

interviews of one hour length each – assuming you use simple 

transcription conventions. If you transcribe for four to six hours per 

day, this translates into two to four weeks of work – a whole month! 

This can already take a big chunk of time out of a three-month 

project (e.g. a Bachelor’s thesis or small assessment project). 
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General hints 

1. It may sound trivial, but it is crucial nonetheless: back up your 

transcript from time to time and create an emergency copy. If 

possible, store it in a different location (e.g. on a USB stick or a 

second computer).  

2. Qualitative data analysis software such as MAXQDA usually 

works with paragraph numbers. Software for data analysis and 

software for data transcription can generate these paragraph 

numbers automatically.  Transcripts can also be printed directly 

in these programs.  

3. If you work with a word processor instead of qualitative data 

analysis software, you can create paragraph numbers there. 

Highlight the whole document and click on the numbering 

button (in the ‘Paragraph’ section of the Home tab in Word™ 

2010), and the paragraph numbers will appear.  

4. Additionally, line numeration can be added in Word™ at a later 

point. Open the file containing the transcript in Word™ and go 

to the ‘Page Layout’ tab. Now select the ‘line numbers’ button. 
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Remarks concerning anonymization 

Normally, transcribed text must be anonymized. This can be done by 

searching and replacing words in a word processor, or directly within 

the transcription software f4. For example, simply search for “Mr. 

Smith” and replace it with “Mr. XYZ”. This is of course only the first 

step – you will have to read the text carefully in order to identify 

passages that might compromise your participants’ anonymity.  

It is important to anonymize data as far as possible directly after 

transcription. Not only does this protect your participants, it also 

saves time (and prevents stress) in the long run. Anonymizing data 

via ‘search & replace’ might change the line numbers in your word 

processing document – this would mean that you’d have to check all 

of your references in your report again if you anonymized after 

analysis & writing. Also, qualitative data analysis software does often 

not feature a ‘search & replace’ function – so you’d have to manually 

search and anonymize every piece of text within the program, which 

is much more painstaking than doing it in a word processor 

(especially because the ease of handling tasks of word processing is 

much lower in QDA software).   Of course you can export your data 

from QDA software into a text document and anonymize it in a word 

processor – but then you suddenly deal with two versions of your 

data, and you will always have to cross-check references in your 

research report. 
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Anonymizing data for your research reports is an important task – if 

you make mistakes, or if you miss to anonymize only one important 

piece of information, the whole effort was in vain, and the identities 

of your participants may be revealed. Thus, it is better to do this work 

as early as possible: Research projects tend to be more stressful 

towards the end, when deadlines are pressing – it is very exhausting 

to do delicate work such as anonymizing at this time. Also, 

anonymizing right after transcription gives you the chance to find 

mistakes or missing anonymizations while you analyze; this is an 

extra safety net for you and your participants.  
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Expecting and avoiding transcription errors 

Each and every transcript contains mistakes after the first time 

through. These mistakes are usually checked and corrected in a 

second round, by reading the transcript while listening to the audio 

recording. Surprisingly, only few errors are pure spelling mistakes. 

The more problematic phenomenon is that often words are omitted, 

replaced, or added. These errors stem from the listener’s natural 

tendency to “co-think” the speaker’s statements while listening. 

Hence, inconsistencies are compensated and the listener fills gaps.  

By unconsciously “correcting” these inconsistencies, the original 

statements are further distorted.  Even small differences can warp 

the meaning of the original message. For example: “I ate the apple” 

vs. “I hate the apple”. 

Isabelle Chiari (2006) demonstrates that untrained transcribers 

produce a mistake in almost every paragraph. Close to 37% of these 

mistakes lead to a semantic distortion of the statement. Therefore it 

is advisable to proofread the completed transcript at least once or 

have another person proof-read the text (“two-man rule”). By doing 

this, most mistakes are tracked down reliably. If it is not possible to 

have someone else proofread the transcript, you should read them 

yourself, allowing some time to pass between the transcription and 

the proofreading. 
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Transcribing – and how software & hardware can help 

Can speech recognition software take some work off my 

shoulders? 

Unfortunately, this is not possible yet. We have thoroughly and 

repeatedly run tests of speech recognition software and the tested 

programs prove themselves incapable of providing automated 

recognition of interviews and group discussions/focus groups. 

(Dresing et al 2008) In interview situations, people often speak in 

dialect, with accents or in colloquial language. Speech recognition 

software cannot identify such variety. Additionally, the software is 

unable to register breaks and emphases. 

There is only one option for using speech recognition software for 

transcribing interviews: training the program to recognize your own 

voice. By this method, you listen to the data and re-narrate what is 

said in the recording. However, even compared to using the hunt-

and-peck method  (100 characters per minute), such a method does 

not provide advantages in terms of work time, since the time saved is 

consumed by the time it will take to incorporate corrections and 

refinements. According to our tests, using speech recognition 

software in the manner outlined above was no match for regular 

transcription in terms of time effort.  
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You will find further literature, comparative tests and additional 

information on the possibilities and limits of speech recognition 

software in academia on our website:  

http://www.audiotranskription .de/Spracherkennung  

(content in German language). 
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Use transcription software – not iTunes™ 

Even though using speech recognition software does not work yet, 

some type of software is needed to transcribe digital data. The first – 

and obvious – thought would be to use a digital music player and a 

word processor. Unfortunately, common programs (such as 

Windows™ media player or iTunes™, among others) are not useful 

for transcribing data. They lack major functions which can support 

and abbreviate the transcription process, for example:  

 slowing down playback speed without distorting the sound 

pitch 

 automated intervals for rewinding when the tape is paused 

(which enables you to hear the last few words after you paused 

the recording) 

 insertion of time stamps (which can be used as links to the 

exact recording position in word processors or qualitative data 

analysis software) 

 (customizable) text elements (e.g. shortcuts for speakers etc.) 

 control of the player with hotkeys or via USB foot pedal.  

Specific programs for audio transcription were not available during 

our PhD research in 2004. Because of this, we developed such a 

program ourselves: “f4”– although it came out a bit too late to help 

us in our own research…   
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By now, f4 has been downloaded over 325,000 times, and it is one of 

the most well known transcription programs in Germany. F4 was 

developed for Windows™ users; for Mac®  users, we developed f5 in 

2010. We continuously develop both programs, and the newest 

versions are available to download on our website 

http://www.audiotranskription.de/english/ 
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Step-by-step guide for f4 (Windows™) and f5 (Mac®) 

F4 and f5 aid you when transcribing your data, e.g. whenever you 

manually type audio or video recordings.  The programs facilitate 

your work in different ways:  

 You can optionally slow down the replay speed (without 

distorting sound pitch) 

 The software can be controlled by using the F4 and F5 keys 

(hence the name) 

 You can be set it up to automatically rewind the recording for a 

few seconds after you paused the tape 

 Time stamps can be (automatically or manually) inserted 

 Text blocks can be inserted via keyboard shortcuts (e.g. for the 

initials of different speakers) 

Transcripts produced in f4 and f5 (including optional time stamps), 

are saved as RTF files, a widely compatible word processing file 

format.  

1. Installing the program 

Download f4 for Windows™ or f5 for Mac OS® from 

http://www.audiotranskription.de/english/. You will also find 

detailed instructions on how to install the program on the site.  

2. Setting up the software 

Open the program. First, set a location for saving backups (you 

can do this in the ‘preferences’ menu).  Now open an audio or 
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video file via the ‘file’ tab or drag-and-drop the desired files into 

the main f4/f5 program window. Next, customize the sound 

output volume, the replay speed and rewinding/forwarding 

intervals. The standard settings normally accommodate most 

users; only the replay speed should be reduced when 

transcribing passages with fast or overlapping speech. 

When transcribing two-person conversations you can activate a 

feature that automatically inserts the name/abbreviation of the 

alternating speakers. You can suppress this function at any time 

by holding down the shift key and the enter-key to create a new 

paragraph.  

3. Transcribing quickly and conveniently 

The ‘F4’ key  (or ‘F5’ key in f5 for Mac®) controls the core 

functions of our software: starting and stopping the playback 

and automatically rewinding the recording in short intervals. 

The functions of f4 & f5 can also be operated via the ‘F4’/’F5’ 

key when other programs are running in the foreground, such 

as continuing to navigate through an audio file while checking 

analysis results in a word processing program. Use the ‘F3’ and 

‘F5’ keys (or ‘F4’ and ‘F6’ keys on Mac®) to rewind or fast-

forward the audio. By using a foot pedal, the programs can be 

controlled even quicker. (Also, in both programs, spoken audio 

remains decipherable while rewinding or fast-forwarding).  
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4. Time stamps – inserted manually or automatically 

Time stamps are important for orientation within a transcript 

and allow for a quick reference to the original audio source. 

They are either automatically inserted at the end of each 

paragraph, or they can be inserted at anytime by pressing the 

‘F8’ button. In f4 & f5 as well as in the qualitative data analysis 

software MAXQDA or ATLAS.ti, these time stamp references are 

active links. In both programs, clicking on the times tamp 

triggers the playback of the relevant part of the audio or video 

recording. When saving a file in f4 & f5, you can choose 

whether to save the transcript with or without time stamps. If 

you transcribe movies or movie fragments, you can define a 

time offset, so that time stamps do not start at zero, but with 

the respective time within the movie.  

5. Tutorials - We have created a series of video tutorials which can 

be viewed on our website 

www.audiotranskription.de/english/f4.htm 
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Time stamps are useful! 

We have already mentioned time stamps earlier. Their usefulness is 

extraordinary, and this is why we would like to cover them explicitly. 

Time stamps are simple numbers indicating a respective position on 

the audio or video track. They enable you to check the transcript for 

possible errors, or to review semantic and ambiguities in intonation 

much later in the analytic process. 

In f4 and f5 they are clickable links. Clicking on a time stamp winds 

the recording to the respective passage and starts the replay. The 

great thing about time stamps is that they also work in the qualitative 

analysis programs MAXQDA and ATLAS.ti. These programs recognize 

time stamps from f4 and f5 and enable you to play back the 

respective sequence of audio on one click. You can go directly back to 

your original recorded data in order to answer analytic questions, or 

to review controversial or odd transcript passages. Oftentimes, being 

able to quickly and conveniently listen to an original passage 

supports you in creating valuable interpretations which are grounded 

directly in your data. Another advantage of time stamps: you can 

reduce the amount of text you transcribe. For example, you can 

create an inventory of topics from an interview, and supplement this 

summary with time stamps. The time stamps allow for quick access 

to the interview data, and needed passages can be transcribed later 

in the process.  
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Using time stamps in computer-aided analysis 

Time stamps from f4 & f5 work in the qualitative data analysis 

programs MAXQDA and ATLAS.ti . As an introduction, we are going to 

show you examples of how to use your f4 and f5 transcripts with time 

stamps in MAXQDA. 

By clicking on a time stamp, it is possible to simply play back the 

actual audio or video data – for example while coding your data. This 

enables you, for example, to hear how a statement was accentuated. 

And this is how it is done: 

Import of the transcript and the media file 

With MAXQDA 2010 it is possible to link f4 and f5 transcripts with 

your audio or video files in MAXQDA’s documents system. In the 

window “Document System,” texts with multimedia files are marked 

with a special icon that includes a small music note symbol.  

Simply import your f4/f5 transcript (* .rtf-file). Usually MAXQDA will 

ask you right away for the location of the matching media file. If not, 

right-click on the imported text, select ‘properties’ and select the 

location of the audio or video file located on your computer.  

Activating the media player 

In order to play back a paragraph upon clicking, you’ll have to open 

the MAXQDA media player. Click on the ‘toolbars’ tab on the top of 

the menu bar, then select the media player icon 
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The player bar will be placed on the toolbar and you can move it 

around within the toolbar. In order to activate the media player, click 

on the small flag on the toolbar. 

 

Now, a new column visualizing the time stamps appears in the 

document browser window. 

 

Play back of audio & video 

Upon clicking one of the time stamp symbols, the recording starts 

playing at the respective position. The playback of video files works 

the same way. However, in order to not only listen to but also see the 

video, you have to also open the video player.  Do this by simply 

clicking the video window button.  
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A very practical tip: If you activate the ‘sync mode’ ((ICON)) during 

longer playback, the time stamp column on the left of the text 

changes its color to blue when the respective passages are playing 

just like a teleprompter. 

 

In order see a list of all your time stamps, click on the ‘list 

timestamps’ icon. In the overview, you can enter a comment for each 

passage surrounded by the two time stamps.  

 

Please note that audio and video files are generally not integrated in 

your MAXQDA project file. They are linked and read from external 

locations (e.g. a folder on your hard drive). This is done in order to 
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keep the overall project file size low and preserves the program’s 

mobility and speed. You have the option to set the external saving 

location in order to organize your project uniformly. You can learn 

how to do this in MAXQDA’s online tutorial on www.maxqda.com. 

 

 

  

http://www.maxqda.com/
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Hints for recording & handling files in particular 

situations  

At www.audiotranskription.de, researchers have repeatedly 

contacted us with technical questions concerning recording and 

transcription issues they have come across in their research practice. 

We have tried to answer most of them, and we would like to 

introduce some of them, all of which come from the collection of 

tutorials available on our website. We hope that our technical hints 

will save you some time and effort, or even open up some new 

possibilities, for your research.  

Recording telephone interviews 

Telephone interviews are an important and cost-efficient method of 

data collection. In the case of phone interviews, the technical task is 

to record both speakers in a reasonable quality. However, the 

recording quality will always be worse than the recording of a face-

to-face interview recorded by a recording device. 

With our small phone recording adapter, telephone conversations 

can be easily recorded. The cable of the receiver has to be connected 

to the telephone by a plug. Detach this plug, place the adapter in 

between. Now connect the adapter’s jack plug with the line-in of 

your recording device. Now you are ready to record all phone 

conversations. 
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Alternatively the adapter can be connected to your computer’s 

microphone input, and the telephone conversations can be recorded 

via recording software. We recommend free programs such as 

Audacity, No23 Recorder or RecOnPhone. A noise filter ensures good 

quality even in soft-spoken passages. When recording the phone 

conversation with a computer, basic knowledge of the control panel 

may be necessary in order to modulate the optimum recording level. 

Another alternative is the telephone adapter (TP-7) manufactured by 

Olympus, which we do not necessarily recommend due to its 

uncomfortable handling and its hygiene issues. If you use this device, 

the type of the phone (wireless phone, cell phone, phone connected 

with wire) does not matter because the adapter is worn in the ear, 

just like a small set of headphones.  

However, inserting the adapter in the ear is rather uncomfortable, 

and due to hygiene reasons it is less suitable if it is to be used by 

several persons (e.g. if it is to be rented out by a library or a 

department).  
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Recording phone conversations with Skype 

Phone calls can be easily recorded if you conduct your phone 

interviews via Skype. There is a series of add-ons and programs which 

allow you to record phone conversations as well as conversations 

with other Skype users. You’ll find a commented list of Skype 

recorders on http://www.aboutonlinetips.com/free-skype-call-

recorders-3308/  

This guide will introduce you to the free “Mp3 Skype Recorder”, 

which – as the name suggests – saves your conversations as mp3 

files. If you want to try out different programs: Wee have created 

two video tutorials on using two other recorders, “wiretap” & 

“callgraph”. The tutorials are available on audiotranskription.de 

(German only). 

Although recording via Skype can make the recording of phone/VoIP 

data much easier, there is also a range of possible technical issues. 

The call quality when using Skype can dramatically diverge, 

depending on your internet and computer speed. If you call another 

Skype user, his/her internet quality and computer speed will also 

drastically influence the call quality. If the connection is bad, you and 

your interviewees might sound very choppy, break up, sound 

somewhat “distant” or distorted, and there might be a delay or echo 

when speaking (especially if you or your interviewees use speakers 

instead of earphones). These technical issues can make interviewees 

feel less comfortable with the overall interview situation or leave 
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them somewhat confused – especially if your interviewees are not 

familiar with VoIP technology and its deficiencies. If you suspect 

sound issues you should explain prior to the interview that you are 

calling from a computer, and that your voice might sound choppy 

sometimes, or that the conversation might break up – but that you’ll 

call again right away. Before you start to conduct interviews via Skype 

you should therefore not only make sure that you and your 

interviewees feel comfortable with the mode of communication – 

but also check if you and the interviewees are familiar with the 

technology (and problems) connected to it. For some additional 

methodological remarks on Skype interviewing, see 

http://squaremethodology.com/2011/01/initial-thoughts-on-

interviews-via-skype/   

 

What you need 

 Skype is free, and it is free to call other Skype users. If you want 

to call phones from your computer, you need to buy calling 

credit from Skype. 

 A microphone & headphones (or a headset). We do not 

recommend using speakers, because they sometimes create 

annoying feedback. (If you interview other Skype users, you 

should make sure your interview partners have a microphone & 

headphones as well…)  

 “Mp3 Skype Recorder” (free), download: 
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http://voipcallrecording.com 

 

Installing and setting up the recorder 

Download the recorder and install it on your computer. Start the 

recorder, and then start Skype. During the very first start, Skype will 

ask you whether you want to allow the recorder to connect with 

Skype – click on “yes” at this point. Depending on your firewall 

settings, a warning might pop up, informing you that the recorder is 

trying to access Skype. You will have to allow this; otherwise, the 

recorder will not be able to record your calls. 

If you want to change the recorder’s access to Skype at a later point: 

You can manage the access of external programs in Skype under 

Tools -> Options -> “Advanced” tab -> “manage other program’s 

access to Skype”. 

 

Recorder options 

To record a Skype phone call or a conversation with another Skype 

user, Skype as well as the recorder have to run. 

The recorder functions are pretty straightforward: You can change 

the bit rate of the recording, and you can choose whether you want 

to record mono, stereo (caller on one channel, called person on the 

other) or joint stereo. Furthermore you can specify whether the 
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program should start on Windows™ startup, and you can change the 

folder in which the program stores your conversations (which we 

recommend since the default folder is somewhat hidden). The 

conversations will be saved as mp3 files. 

 

How to record 

The recorder can be set up to start a recording as soon as your 

conversation partner picks up (We strongly discourage this setting, 

because it might lead to accidental recordings without the 

interviewee’s prior consent). If the recording button has no square 

around (click on the recording button prior to the Skype 

conversation), the recording will automatically start as soon as the 

next Skype conversation starts (note that the recorder is not 

recording prior to the call). 

 

If the recording button doesn’t have a square surrounding it, the 

recording will NOT start on start of the conversation – you can start it 

manually whenever you want to during the conversation. If the 
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player is set up like this and not recording, you will see a red bar on 

the bottom of the recorder with the message “recording off”. 

 

Every time a recording is started, this window will pop up for a short 

time (check the bottom right of your screen), indicating that you are 

actually recording: 

 

The recording will stop either when you push the stop button or 

when you hang up your call. The file will then be automatically saved 

– another pop-up window will inform you of that. The file will be 

saved in the location that is shown on the player. 

Before calling your interview partners, you should do some test calls 

in order to get acquainted with the controls, and to make sure the 

quality is alright. 
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Converting audio files 

It is sometimes necessary to convert your recordings, for instance if 

you work on a Mac®, but your interviews are saved as WMA file; or if 

you have an uncompressed recording from a high quality recorder 

which leaves you with a file of over 500 MB. 

For converting audio files, we recommend programs such as Audacity 

(Mac® and PC), all2mp3 (Mac® ), Switch and xrecord. They are 

perfectly able to convert audio recordings into other formats (e.g. 

mp3). We will show you how easy file conversion is by example of the 

software Switch7: 

1. Select audio file 

Install and start Switch. Select the files you want to convert or drag 

the files into the open program window. It is also possible to select 

various audio recordings or a whole folder. 

2. Specify the destination and format 

On the lower part of the program window specify the preferred 

output format, for example OGG or MP3. You can indicate the 

preferred output folder in the input field above.  

3. Converting 

                                         
7 Free download available at: http://www.nch.com.au/switch/de/index.html 

 

http://www.nch.com.au/switch/de/index.html
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Upon clicking on the ‘convert’ symbol (top right), converting begins. 

This process can take a few minutes depending on the file size. If you 

convert files into MP3s, a window for the codec settings is displayed 

first. Click on ‘OK’. The conversion is complete when the progress bar 

reaches 100 percent. The file will be located in the folder you 

previously selected. 
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Noise Removal 

With the free software Audacity (http://audacity.sourceforge.net/), 

which supports all common audio formats, it is possible to reduce 

noise from an audio recording easily and within a few clicks. The 

procedure is as follows: 

1. Determine the noise profile 

Install and start Audacity, open the interview via the the ‘File’ menu. 

You can now see the file in waveform. You can listen to the file by 

clicking the “Play” button; a vertical bar indicates the current position 

in the file. In order to skip to a certain position, just click on the wave 

form. Search for a position where you only hear background noise 

(for instance, a short conversation break), select the part that’s silent 

except for the noise. Then choose ‘Noise Removal’ from the ‘Effect’ 

Menu and click ‘Get Profile’. 

2. Remove noise 

Select all of the audio (CTRL + A), choose ‘Effect’ > ‘Noise Removal’ 

again. This time, select the “Noise Removal” button. Now click on 

‘preview’ 

3. How to get optimal results 

In order to optimize the result, you can experiment with adjusting 

the noise threshold with a different noise removal level. If you get a 

satisfactory result, click on ‘OK’. 
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4. Finishing up and exporting 

In order to finalize the changes in the audio recording, the project 

must be exported. Go to the ‘File’ menu and choose ‘Export’. If 

necessary, add metadata to your file and confirm with ‘OK’. In the 

subsequent window, select your preferred file type (most commonly 

MP3) and the saving location. 
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Trimming audio files 

Sometimes a recording contains unwanted content from before or 

after the interview itself.  For trimming audio files, we also 

recommend Audacity for trimming audio files. 

1. Selecting a file 

Install and start Audacity, open the interview via the ‘File’ menu. You 

can now see the file in waveform. You can listen to the file by clicking 

the ‘Play’ button; a vertical bar indicates the current position in the 

file. In order to skip to a certain position, just click on the wave form. 

Highlight a selection you want to cut by holding the left mouse 

button and moving the mouse.  

2. Trimming 

You can delete the selected part by pressing the ‘Del’ key on your 

keyboard. 

3. Cutting and exporting 

Would you like to store the actual selection as a separate file (For 

example; as a sound sample for a transcription service)? Select the  

‘File’ menu, then ‘Export’. Your snippet will now be shown in a new 

window. 

4. Finishing up and exporting 

In order to finalize the changes in the audio recording, the project 

must be exported. Go to the ‘File’ menu and choose ‘Export’. If 
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necessary, add metadata to your file and confirm with ‘OK’. In the 

subsequent window, select your preferred file type (most commonly 

MP3) and the saving location. 
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Data security and recovering deleted data 

Deleting data by mistake is annoying. Whether it is the important 

interview, the written transcript or any other data; once deleted 

unintentionally, one can be sure of a surge of adrenaline. 

Fortunately, there is a free tool that can help in such a situation: 

Recuva. 

1. Make preparations 

If possible you should not save additional data on the drive where the 

deleted data is located – at least until the recovery is complete, so 

that the lost data is not overwritten. Download and install the 

software from: http://www.piriform.com/recuva. 

2. Using the wizard for recovery 

Open Recuva and use the wizard. It is best to search for all file types. 

In the next step, make sure that ‘in-depth scan’ is activated - only 

then Recuva can really find most of the data. 

3. Searching and restoring lost data 

The search itself can take between ten minutes and several hours 

(400 GB hard drive approximately takes 6 hours to scan). The search 

result is listed in a table, from which you can select single, several or 

all restorable data and save it onto another drive. After selecting the 

files, press the button ‘recover’ and all the selected data is restored – 

impressive. 

http://www.piriform.com/recuva
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An important conclusion 

While we were very happy with the results Recuva delivered, we 

found out something interesting. You can restore nearly almost all 

data with Recuva. Not only data that was deleted an hour ago can be 

restored, but also data from a completely formatted hard drive 

(which had been used earlier). 

Not a problem? But yes! Think about the following situation:  

You sell your old notebook, your external hard drive or your USB flash 

drive. The buyer has the possibility to restore data with Recuva and 

therefore can get into possession of information that was not meant 

to be his or hers. 

Or: You have a rental recording device. In this case, every subsequent 

user can at least recover and listen to a part of previously deleted 

interviews. 

After consulting computer scientists we realized that empty and 

formatted storage media are never completely empty. If you deal 

with sensitive information such as interviews (which are subject to 

privacy policies and informed consent agreements), analysis results, 

images and much more, you cannot pass your data storage hardware 

on to someone else without making sure that the data is 

permanently deleted. 
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Deleting data safely (permanently!) 

Overwriting data once should normally do the job. It is also sufficient 

to simply delete the sensitive data and then to fill the device to the 

brim with useless data manually.8  

Repeated overwriting is not necessary in the case of magnetic hard 

drives or flash memory drives. In the case of flash drives it might 

happen that some data is retained in flash cells that only serve as 

buffers or as replacement of defective cells. 

The probability that something usable remains in these cells is on one 

hand very low, and it would, on the other hand, call for a huge effort 

to retrieve the data. Our recommendation is to use a special deletion 

program. “Eraser” is a good solution, which is recommended by the 

computer magazine c’t and the German Federal Commissioner for 

Data Protection and Freedom of Information 

But if you have *really* sensitive data, you should destroy flash-

media (and of course CDs) physically. 

 

  

                                         
8
 The program “H2testw v1.4” provided by the computer magazine c’t fills storage memory completely upon 

testing hardware and therefore should be able to overwrite all data: 
http://www.heise.de/software/download/h2testw/50539 

http://www.heise.de/software/download/h2testw/50539
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